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THE SIX DESIGN TIPS
1. PLACE THE ORDER CORRECTLY

Remember to include all order details when placing your order.

Typical order details:
	Ì Product (which printed item you want)
	Ì Quantity (how many you need)
	Ì Your phone number – preferably mobile
	Ì Delivery address
	Ì Billing address 

Order online and avoid problems 
When you order through the website, you make sure all relevant information is included.

2.  USE THE CORRECT COLOURS

With the exception of certain products printed with Pantone colours, your print products are produced using 
the four CMYK colours.

Remember to supply your print file in CMYK
Most graphic design programs allow you to work in CMYK colours instead of RGB.

How to define black 
If you need to define black for solid areas using CMYK, the best result is achieved 
with: C=60 M=40 Y=40 K=100. Black text and line drawings should, however, be 
defined as: C=0 M=0 Y=0 K=100

Pantone colours
As mentioned, some products are printed with Pantone, which are spot colours that cannot be created using 
the CMYK scale. It is important that the Pantone colour is set up as a spot colour in, for example, InDesign.
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3. USE THE CORRECT FILE TYPE

You get the best results when using PDF format with all fonts embedded in the file.

OTHER POPULAR FILE TYPES

TIF/JPG
Almost all graphic programs allow you to save in TIF and JPG image formats. 
Save the file in maximum quality, in CMYK colours, and at a minimum of 300 ppi. 
If your print product contains text, we recommend at least 600 ppi for optimal sharpness.

EPS
A popular vector format that typically gives better results than TIF/JPG. Remember to convert all fonts to curves (vecto-
rised/outlined). Fonts may also be embedded in the file.

InDesign, Photoshop and Quark
Export to PDF format. Alternatively, export to EPS, open the EPS file in Illustrator, convert all fonts to outlines, and save 
as EPS/PDF.

Microsoft Office (Word, Excel, PowerPoint, Publisher)
Print to PDF format (requires Adobe Acrobat or a free PDF writer). 

Please note that Microsoft Office formats are not intended for graphic production, and we do not accept responsibility 
for colours in the final printed product.

Free PDF generator:
If you have trouble generating PDF files, you can download a free PDF writer from sites such as www.cutePDF.com.

4. USE THE CORRECT RESOLUTION (PPI)

By using the correct dpi, you avoid a grainy or blurry print result. As a general rule, print files should be  
supplied at 300 ppi. We do not recommend creating text as bitmap.

DPI or PPI?
Although the terms DPI (dots per inch) and PPI (pixels per inch) both describe
image resolution or sharpness, they are not the same. 
 
PPI describes the number of pixels displayed per inch on a screen. 
DPI is used in print and describes the number of physical ink dots on a printed product.

	Ì Images viewed at reading distance, for example a brochure (10–50 cm): minimum 150 ppi–300 ppi for 
the best result
	Ì Images viewed at standing distance, for example posters and roll-ups (more than 50 cm): minimum 60 

ppi, preferably 100 ppi
	Ì Images for banners viewed from several metres away: 5–50 ppi, depending on whether the viewing 

distance is 5 or 20 metres.

5 ppi may sound very low, but it means each pixel is 0.5 x 0.5 cm. At 20 metres, such a small dot is not
visible, which is why 5 ppi can work just fine.

EPS

EPS

EPS
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5. REMEMBER BLEED

This is the most important advice, as many mistakes 
happen here.

Add 3 mm bleed to the layout 
Most importantly, remember to add 3 mm on all 
sides of the print product, also called bleed.

Text and graphic elements should have a safety 
margin of at least 3 mm from the final trim edge of 
the product.

See more trimming tips under document setup.

6. OVERPRINT AND OUTPUT

Avoid unpleasant surprises where elements disappear.

InDesign, Illustrator and Acrobat can be set to always display overprint. 
This helps you spot any problems with the colour layers in your layout.

Overprint in InDesign and Illustrator
Turn on Overprint Preview in InDesign so the layout simulates the final print result: 
InDesign > View > Overprint Preview

Overprint in Acrobat Pro
Check for errors in the print-ready PDF. We always recommend turning on overprint preview: 
Edit > Preferences > Page Display > Page Content and Information > Use Overprint Preview > Always

Output Preview in Acrobat
You can also use Output Preview as a tool. Turn on Simulate Overprint in Acrobat: 
View > Tools > Print Production > Output Preview > Simulate overprinting.

Overprint No overprint

Background graphics and colours must extend 
all the way to the edge – i.e. 3 mm beyond the 
final trim edge.

Text, images and logos should be placed within the 
safety zone, at least 3 mm from the final trim edge.

The final size of the printed product after trimming.

 BLEED AREA

SAFETY ZONE 

FINAL TRIM EDGE
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TEMPLATES
Most print providers offer templates for designing print products. 
Templates typically include guidance on bleed, safety zones, document size, and more. 
 
Contact your advisor if you want a template for a standard print product.

DOCUMENT SETUP
This is how to set up your file if you do not want to use templates.

1.	 Start a new document 
This may also be called “new page”, “new canvas” or “new artboard”. 

2.	 Document setup – InDesign 
Set the document size to the final format of the print product, for example business cards (85 x 54 mm). 

3.	 Add 3 mm bleed and 3 mm safety zone  
This is done in the New Document menu under bleed and margins. 

4.	 Document setup – other programmes. 
Set the document size 3 mm larger on all four sides than the final size of the printed product. 
This is called adding bleed.

Example of adding 3 mm bleed:
Print product Final size Document size
Businesscard 85 x 54 mm 91 x 60 mm

A6-postcard 105 x 148 mm 111 x 154 mm

A5-flyer 148 x 210 mm 154 x 216 mm
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Incorrect placement of text – correct background Correct placement of both text and background

Incorrect placement of background graphics Correct placement of background graphics
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THE THREE TRIMMING TIPS

Follow these three tips, and you will avoid most trimming errors.

TIP 1
Set up your layout in the correct size from the start.

Final size:	
Layout-size

(working area):
A0-size (841 x 1189 mm) 847 x 1195 mm

A1-size (594 x 841 mm) 600 x 847 mm

A2-size (420 x 594 mm) 426 x 600 mm

A3-size (297 x 420 mm) 303 x 426 mm

A4-size (210 x 297 mm) 216 x 303 mm

A5-size (148 x 210 mm) 154 x 216 mm

A6-size (105 x 148 mm) 111 x 154 mm

A7-size (74 x 105 mm)	 80 x 111 mm

Business card (54 x 85 mm)	 60 x 91 mm

TIP 2
Graphics that should go to the edge must cover the entire layout area (including bleed).

TIP 3
Do not place text too close to the edge.
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WHY BORDERS AND TEXT NEAR THE EDGE ARE NOT RECOMMENDED

See how a trim variation of just 1 mm affects a layout that is “theoretically” correct. 
If trimming could be more precise than ±1 mm, 3 mm bleed would not be necessary — but it is.

Theory: The border should be 2 mm wide all
the way around.

In practice: The border may end up being 1 mm 
on one side and 3 mm on the other.

Theory: The border should be placed 3 mm from 
the edge all the way around.

In practice: The border may end up being 2 mm 
from the edge on one side and 4 mm on the other.

Theory: Right- and left-aligned text should be 
placed 3 mm from the edge.

In practice: The text may end up being 2 mm
or 4 mm from the edge.
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PREMIUM PRINT FILES
This type of print product places specific requirements on your print files.

Choose between:
	Ì Gold foil
	Ì Silver foil
	Ì 3D varnish

Each effect used must be defined in the print file as a unique spot colour. 
The specific colours used for the different effects are not important, but a strong 
contrast to the main print file is an advantage.

Partial varnish should be named “VARNISH”, silver foil “SILVER”, and gold foil 
“GOLD” — always in uppercase.

OVERPRINT

Overprint must always be applied to the partial effect elements, regardless of 
whether there is print colour beneath the effect.

OVERLAP 

Effects that overlap must knock each other out, so multiple layers are not applied on top of one another. This 
is because varnish is used that adheres to the foil, and overlapping layers therefore become too thick.
Fig. A1 on the left shows the three variants in the final file. Fig. A2 shows the elements separated.

SMALL ELEMENTS

Please note that partial varnish and foil work best when elements are placed at least 3 mm apart, from the 
edge and/or from a fold. We do not recommend font sizes below 12 pt.

Fig. A1 Fig. A2

VARNISH SILVER GOLD

Go
 to

 s
ta

rt



MISREGISTRATION

Since each effect is applied to the print sheet in a separate production step, misregistration may occur on 
elements with low tolerance. (Fig. B1).Always take this into account in your design. Fig. B2 shows a shift of 
just 0.3 mm can be visible.

NEGATIVE EFFECT

If you want a negative foil effect, elements – such as the text shown on the right (Fig. C1) – must be created 
with sufficient tolerance. The foil overlaps the underlying graphics while also accounting for possible misreg-
istration. Fig. C1 is made using a white background box (Fig. C2). The same result can also be achieved using 
a stroke (Fig. C3).

Fig. B1 Fig. B2

VARNISH SILVER GOLD

Ficipiet fuga. Mint 
occusa que plignis et 
ad eatem rerum aut 
et andis est, quam 
ratem quam lia niet 
labor alMo tem inc-
tem. Dam alibusdae

Ficipiet fuga. Mint Ficipiet fuga. Mint 
occusa que plignis et occusa que plignis et 
ad eatem rerum aut ad eatem rerum aut 
et andis est, quam et andis est, quam 
ratem quam lia niet ratem quam lia niet 
labor alMo tem inc-labor alMo tem inc-
tem. Dam alibusdaetem. Dam alibusdae

Fig. C1 Fig. C2 Fig. C3
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COLOUR PROFILES
 For coated paper, such as Silk, FOGRA39 is recommended.
 For uncoated paper, such as offset, FOGRA47 is recommended.

FILE EXPORT
We recommend installing the print provider’s export settings if you design your print product in Adobe soft-
ware such as InDesign, Illustrator or Photoshop.

HOW IT WORKS

1. Download the ZIP file and extract it
2. Double-click the file
3. The export setting is now installed and available in your InDesign menu

Contact your advisor to receive the export settings.

THE BENEFITS OF EXPORT SETTINGS

When you use the print provider’s export settings, the following should be under control:

•	 Transparency issues
•	 Bleed issues
•	 Missing fonts
•	 Unnecessarily high resolution

Always ask your print provider for their export settings.

CORRECT EXPORT – SINGLE PAGES OR SPREADS

When exporting your print file from InDesign, you can choose whether to export 
pages as single pages or spreads.

	Ì �Most print products should be exported as single pages in one PDF document  
and in the correct order.
	Ì �Covers and folded products should be exported as spreads in one  

PDF document, with the pages correctly assembled. 
Remember to include a spine if you are producing a perfect bound book.

Unavngivet 1   2-3Unavngivet 1   2-3 29-11-2021   11:19:0329-11-2021   11:19:03

Unavngivet 1   1Unavngivet 1   1 29-11-2021   11:18:1129-11-2021   11:18:11

Spreads

Single page
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CHECKLIST BEFORE UPLOAD
	5 Correct bleed

I have added correct bleed, and my print file is therefore 3 mm larger on all edges than the final printed product.

	5 Correct safety zone
I have placed text, graphics and logos within the safety zone, at least 3 mm from the edge of the print product.

	5 Correct resolution
All images in my print file have a resolution of at least 300 dpi when placed at 100% in the document. 
A quick tip: if you are unsure whether the resolution is good enough, zoom your screen view to 200–300%. 
If it still looks sharp and not pixelated, it will usually also print well.

	5 Correct colours
My print file is created in CMYK. 
If I have inserted images or other elements in RGB or Pantone colours, I let the print provider convert them to 
CMYK for the best possible result.  
I understand that colours may change during conversion.

	5 Correct PDF with embedded fonts
All fonts were embedded when I exported my PDF file.

	5 No spreads in multi-page print products
My PDF file contains the pages in sequence. A 24-page booklet therefore requires a PDF with 24 pages. 
Do not submit PDF files with facing pages set up as spreads.

FREE FILE CHECK
Most print providers offer a free, non-binding check of your print files.

Typical checks include:
	Ì Correct bleed
	Ì Correct resolution (dpi)
	Ì Format/file type
	Ì Correct colours

Ask your advisor which errors or issues
are included in the file check.

Go
 to

 s
ta

rt


	6. OVERPRINT OG OUTPUT
	5. HUSK PLADS TIL BESKÆRING
	4. KORREKT OPLØSNING (PPI)
	3. BENYT KORREKT FILTYPE
	2.  ANVEND KORREKTE FARVER
	1. AFGIV KORREKT BESTILLING 
	Dokumentopsætning
	De tre beskæringstips

	Negativ effekt
	Overlap
	Overprint
	Farveprofiler
	Tjekliste inden upload

	Indhold Knap 8: 
	Knap 9: 


